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NOTICE

DANIEL MEASUREMENT AND CONTROL, INC. AND ROSEMOUNT ANALYTICAL, INC. (COLLECTIVELY,

“SELLER”) SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS IN THIS MANUAL OR

OMISSIONS FROM THIS MANUAL. SELLER MAKES NO WARRANTIES, EXPRESSED OR IMPLIED,

INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE WITH RESPECT TO THIS MANUAL AND, IN NO EVENT, SHALL SELLER BE LIABLE FOR ANY

SPECIAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PRODUCTION,

LOSS OF PROFITS, ETC. 

PRODUCT NAMES USED HEREIN ARE FOR MANUFACTURER OR SUPPLIER IDENTIFICATION ONLY AND

MAY BE TRADEMARKS/REGISTERED TRADEMARKS OF THESE COMPANIES. 

THE CONTENTS OF THIS PUBLICATION ARE PRESENTED FOR INFORMATIONAL PURPOSES ONLY, AND

WHILE EVERY EFFORT HAS BEEN MADE TO ENSURE THEIR ACCURACY, THEY ARE NOT TO BE

CONSTRUED AS WARRANTIES OR GUARANTEES, EXPRESSED OR IMPLIED, REGARDING THE

PRODUCTS OR SERVICES DESCRIBED HEREIN OR THEIR USE OR APPLICABILITY.  WE RESERVE THE

RIGHT TO MODIFY OR IMPROVE THE DESIGNS OR SPECIFICATIONS OF SUCH PRODUCTS AT ANY TIME.

SELLER DOES NOT ASSUME RESPONSIBILITY FOR THE SELECTION, USE OR MAINTENANCE OF ANY

PRODUCT. RESPONSIBILITY FOR PROPER SELECTION, USE AND MAINTENANCE OF ANY SELLER

PRODUCT REMAINS SOLELY WITH THE PURCHASER AND END-USER.

 

DANIEL AND THE DANIEL LOGO ARE REGISTERED TRADEMARKS OF DANIEL INDUSTRIES, INC. THE

ROSEMOUNT AND ROSEMOUNT ANALYTICAL LOGO THE ARE REGISTERED TRADEMARKS OF

ROSEMOUNT ANALYTICAL, INC. THE EMERSON LOGO IS A TRADEMARK AND SERVICE MARK OF

EMERSON ELECTRIC CO. 

COPYRIGHT © 2005

BY DANIEL MEASUREMENT AND CONTROL, INC.,

HOUSTON, TEXAS,

U.S.A.

All rights reserved.  No part of this work may be reproduced or

copied in any form or by any means - graphic,  electronic, or

mechanical — without first receiving the written permission of

Daniel Measurement and Control, Inc. Houston, Texas, U.S.A. 
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WARRANTY

1. LIMITED WARRANTY: Subject to the limitations contained in Section 2 herein and except as otherwise

expressly provided herein, Daniel Measurement and Control, Inc. and Rosemount Analytical, Inc., (collectively “Seller”)

warrants that the firmware will execute the programming instructions provided by Seller, and that the Goods

manufactured or Services provided by Seller will be free from defects in materials or workmanship under normal use

and care until the expiration of the applicable warranty period. Goods are warranted for twelve (12) months from the

date of initial installation or eighteen (18) months from the date of shipment by Seller, whichever period expires first.

Consumables and Services are warranted for a period of 90 days from the date of shipment or completion of the Services.

Products purchased by Seller from a third party for resale to Buyer ("Resale Products") shall carry only the warranty

extended by the original manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond making a

reasonable commercial effort to arrange for procurement and shipping of the Resale Products. If Buyer discovers any

warranty defects and notifies Seller thereof in writing during the applicable warranty period, Seller shall, at its option,

promptly correct any errors that are found by Seller in the firmware or Services, or repair or replace F.O.B. point of

manufacture that portion of the Goods or firmware found by Seller to be defective, or refund the purchase price of the

defective portion of the Goods/Services. All replacements or repairs necessitated by inadequate maintenance, normal

wear and usage, unsuitable power sources, unsuitable environmental conditions, accident, misuse, improper installation,

modification, repair, storage or handling, or any other cause not the fault of Seller are not covered by this limited

warranty, and shall be at Buyer's expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer

or any other party except as may be agreed upon in writing in advance by an authorized Seller representative. All costs

of dismantling, reinstallation and freight and the time and expenses of Seller's personnel for site travel and diagnosis

under this warranty clause shall be borne by Buyer unless accepted in writing by Seller. Goods repaired and parts

replaced during the warranty period shall be in warranty for the remainder of the original warranty period or ninety (90)

days, whichever is longer.  This limited warranty is the only warranty made by Seller and can be amended only in a

writing signed by an authorized representative of Seller. Except as otherwise expressly provided in the Agreement,

THERE ARE NO REPRESENTATIONS OR WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED, AS TO

MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE, OR ANY OTHER MATTER WITH RESPECT

TO ANY OF THE GOODS OR SERVICES.  It is understood that corrosion or erosion of materials is not covered

by our guarantee. 

2. LIMITATION OF REMEDY AND LIABILITY: SELLER SHALL NOT BE LIABLE FOR DAMAGES

CAUSED BY DELAY IN PERFORMANCE. THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF

WARRANTY HEREUNDER SHALL BE LIMITED TO REPAIR, CORRECTION, REPLACEMENT OR REFUND

OF PURCHASE PRICE UNDER THE LIMITED WARRANTY CLAUSE IN SECTION 1 HEREIN. IN NO EVENT,

REGARDLESS OF THE FORM OF THE CLAIM OR CAUSE OF ACTION (WHETHER BASED IN CONTRACT,

INFRINGEMENT, NEGLIGENCE, STRICT LIABILITY, OTHER TORT OR OTHERWISE), SHALL SELLER'S

LIABILITY TO BUYER AND/OR ITS CUSTOMERS EXCEED THE PRICE TO BUYER OF THE SPECIFIC

GOODS MANUFACTURED OR SERVICES PROVIDED BY SELLER GIVING RISE TO THE CLAIM OR CAUSE

OF ACTION. BUYER AGREES THAT IN NO EVENT SHALL SELLER'S LIABILITY TO BUYER AND/OR ITS

CUSTOMERS EXTEND TO INCLUDE INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES. THE TERM

"CONSEQUENTIAL DAMAGES" SHALL INCLUDE, BUT NOT BE LIMITED TO, LOSS OF ANTICIPATED

PROFITS, LOSS OF USE, LOSS OF REVENUE AND COST OF CAPITAL. 
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1.0 INTRODUCTION

GCOPC is a server application program that acquires both real-time and historical data from Daniel

Danalyzer and Rosemount Analytical Process Gas Chromatographs and makes the data available

to clients on an Ethernet network using standard OPC protocols. Data acquisition from the gas

chromatographs can be via direct connection (RS-232, RS-485) asynchronous serial interfaces using

Modbus ASCII or Modbus RTU protocols, or via an Ethernet network connection using

Modbus/TCP protocol. The most recent results of the gas chromatograph analysis are made available

via an OPC DA interface.  Historical results for the most recent seven days of analyses are presented

via an OPC HDA interface. Additional information on  OPC specifications,  including details on

DA, HDA, etc. are available from the OPC Foundation website at www.opcfoundation.org.

The following table lists the common acronyms, abbreviations, and definitions.

ACRONYM OR

ABBREVIATION

DEFINITION

DA Data Access

HDA Historical Data Access

real-time access to stored data

HMI Human/Machine Interface

OPC Open Connectivity via open standards that ensure

interoperability of industrial automation and

enterprise systems provided by the OPC foundation.

COM MicroSoft’s OLE COM (Component Object Model)

set of objects, interfaces and methods used in process

and manufacturing applications.

DCOM MicroSoft’s OLE DCOM (Distributed Component

Object Model) set of objects, interfaces and methods

used in process and manufacturing applications.
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2.0 INSTALLATION

To install the GCOPC program, insert the CD into the CD-ROM drive. Note that this program

requires Windows Installer v2.0. The Auto-Installer should begin, but if not, select the Start menu,

and click Run.  The path to the CD-ROM drive may then be typed in, or click the Browse button.

The Browse dialog box appears..

Using the Look in pull-down menu, select the target CD-ROM, and double-click ‘Setup.exe’.
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Click the Run button via the dialog box. The installation process will proceed. Follow the on-screen
instructions.

After the installation process is complete, the following files are placed in the C:\Program
Files\Emerson Process Management\GCOPCCFG folder.

GCOPC.doc (v2.00)

GCOPC.exe (v2.00)

GCOPCCFG.EXE(v2.00)

GCOPCCFG.HLP(v2.00)

instsrv.exe(no version information)

MFC42.dll (v6.0.8665.0)

MODBUS.dll (v1.00)

MSVCP60.dll (v6.0.81668.0)

MSVCRT40.dll (v4.22.0.0)

MSVCRT.dll (v6.0.8797.0)

OLE32.dll (v4.71.2612.0)

OLEAUT32.dll (v2.40.4275.1)

OLEPRO32.dll (v5.0.4275.1)

OPC Core Components 2.00 SDK 2.20.msi (no version information)

REGSVR32.exe (v5.0.1641.1)

srvany.exe(no version information)

WtHDAsvr.dll (v2.0.0.1)

WtOPCSvr.dll (v9.0.0.6)
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2.1 Installing the Proxy/Stub Drivers (DLLs)

In order to run any OPC  client or server, there are several proxy/stub drivers (DLLs) that must be

installed and registered. If the Proxy/Stub drivers are not already installed, the ‘OPC core

components 2.00 SDK 2.20.msi’ file must be run. It will perform this task automatically. This file

is found in C:\Program Files\Emerson Process Management\GCOPCCFG .

To run the ‘OPC core components 2.00 SDK 2.20.msi’ file, click the Start button, then click Run.
Click the Browse button, and using the Look in pull-down menu, select the path C:\Program

Files\Emerson Process Management\GCOPCCFG . The ‘OPC core components 2.00 SDK

2.20.msi’ is not an executable file. To select this file, the Windows ‘All Files’ feature must be

selected for the ‘Files of type’ field at the bottom of this dialog box. When Windows displays all the

files in the GCOPC folder, double-click on the ‘OPC core components 2.00 SDK 2.20.msi’ file.
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Finally, click the OK button in the Run dialog box, and follow the on-screen installation
instructions. 



GCOPC USER MANUAL JUL 2005

SECTION 2 2-5



JUL 2005 GCOPC USER MANUAL

INSTALLATION2-6

The server’s DCOM setting must be configured in order for the GCOPC to operate in a distributed

environment. If you are unfamiliar with configuring DCOM, contact your Network Administrator

or refer to the Knowledge Base at www.microsoft.com. GCOPC has two server interfaces,

GCOPCDA and GCOPCHDA.
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3.0 OPERATION

The File menu contains:

Select - selects an existing server (one per GC) to view/configure. Upon selection, a GC Server
dialog box will appear.

Controller Def. File - text files that define the tag list, historical data records, as well as
other configuration parameters. The format of these files is defined in Section 5.0.

Browse - locate and select the definition file

Server Rate - defines the frequency that GCOPC will poll each GC for new data

Tag Delimiter - defines the character that separates parts of each tag. For example, if ‘.’

is used, tags would appear such as ‘Unit1.Flow.Temp’.

Port - At the Modbus ID submenu, select the port (serial or Ethernet) to communicate with

the GC, configure the port-specific communication parameters, and assign the Modbus

address.

Settings Button - To configure the Modbus settings for each GC port, under the

File menu, click the Modbus ID submenu.

Modbus ID - To configure the Modbus settings for each GC port, under the File menu,

click the Modbus ID submenu.

Register Mode - should be left as the default “Daniel” in order to work properly with
standard gas chromatograph applications which are supported by GCOPC

Prev/Next buttons - page through defined servers

Save button - save changes

Cancel/Close button - shows cancel if changes have been made or close if no pending

changes

Add  - creates a new server (up to maximum 16)

 - dialog to name the server

 - once named, goes to the configuration dialog as per the Select menu

Delete - deletes a server (Note: User must delete the service, etc.)
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To begin using the GCOPC program for the first time, the operator must run ‘GCOPCCFG.exe’ and

add server(s). The ‘GCOPCCFG.exe’ program is located in the GCOPC Installation folder, which
is found via the path C:\Program Files\Emerson Process Management\GCOPCCFG. A shortcut

may be created on the desktop if desired. 

To run ‘GCOPCCFG.exe’, click the Start menu, then click Run.  Type in the path C:\Program
Files\Emerson Process Management\GCOPCCFG or use the Browse button option. 

Using the Look in menu from the Browse button, locate ‘GCOPCCFG.exe’ in the GCOPC folder
(C:\Progam Files\Emerson Process Management\GCOPCCFG), and double-click GCOPCCFG.exe.
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From the Run menu, click the OK button. The GCOPCFG window will appear.

To add a server, select the File menu and click the Add submenu.
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Type in a server name and click the OK Button.

The Server Configuration dialog box will appear.
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The path to the ‘Controller Definition File’ may be typed in, or use the Browse button to locate and
assign a ‘Controller Definition File’ for this server.

Next, configure which computer port the GCOPC program will use to connect to the GC Controller

by choosing from the list of available communication ports in the computer (serial ports and

Ethernet cards) via the Port dialog box.

Highlight the desired communications port and click the mouse button.

Once the communications port has been selected, the operator must then set up the communications

parameters via the Settings button.

Below is the Ethernet Port Configuration dialog box. The operator must enter the GC

controller’s IP Address. 
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Below is the Serial Port Configuration dialog box that will be shown if a serial port is selected
for communications. All communications parameters must match the serial port of the GC

controller. 

Once all the communications data has been entered, click the OK button and the Save
Confirmation dialog box will appear. 
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Click Yes to save the changes. When Server Configuration window reappears, click the Save
button to save all changes made. The Save Confirmation dialog box will appear. 

Click the Yes button to save the changes made in the Server Configuration dialog box.

The operator may exit the Server Configuration window via the Close button and return to the main

GCOPCCFG window.
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By clicking the File menu, the operator now has options to Add more servers, Delete existing
servers, or Select and edit an existing server. To add another server the operator would repeat the
above process.
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3.1 Setting up the Servers as an NT Service

After all servers have been configured per Section 3.0 above, they must be set up as NT Services.

This feature allows the GCOPC servers to run in the background transparent to the user.  To

accomplish this, the operator must execute ‘Instsrv.exe’ from the installed GCOPCCFG folder.

‘Instsrv.exe’ installs and removes System Services from NT. 

Using the MS-DOS
®
 Prompt, the operator must change to the GCOPCCFG-installed folder found

under the path C:\Program Files\Emerson Process Management\GCOPCCFG . 

1) Click the Windows Start button.
2) Click Run.
3) In the Run dialog box, type “cmd” and click the OK button.
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4) This will bring up a DOS window. Note: For this example screen, the primary hard drive is

E:\. Most computer’s primary hard drive will be C:\.

5) Change to the root directory by typing in ‘cd\’ and press the  Enter key.
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6) From the command prompt, type the following command syntax:

CD\Program Files\Emerson Process Management\GCOPCCFG

and press the Enter key.

7) From the installed GCOPC folder, the command syntax to start the Server as an active

service is entered. For this example, the server name ‘Server1’ is used. Type the following

command syntax exactly as shown:

Instsrv  Server1 “C:\Program Files\Emerson Process Management\GCOPCCFG\Srvany.exe”

and press the Enter key.
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8) At this time, the following message will appear.

9) Repeat Step 7 for each server. For each server created, a folder will be added to the

GCOPCCFG folder bearing its name (i.e. Server1, Server2, Server3…).
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Note: The service may be removed in the same manner using the following command syntax:

Instsrv Server1 remove “C:\Program Files\Emerson Process Management\GCOPCCFG\srvany.exe”

To exit the DOS command prompt screen, type Exit and press the Enter key or using the mouse

pointer, click on the X in the upper right-hand corner of the command prompt window.
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4.0 SETTING UP THE SERVICES IN THE REGISTRY

Adding the services to the registry will enable them to be automatically started when the computer

is started.

1) Click the Start button.
2) Click Run.
3) In the Run dialog box, type in “regedit”and click the OK button,.

The Registry Editor window appears.
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4) Using the mouse pointer, click the ‘+’ sign next to the HKEY_LOCAL_MACHINE folder.
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5) Expand the SYSTEM folder in the same manner.
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6) Expand the CurrentControlSet folder.
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7) Expand the Services folder. 
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8) Scroll down and locate the GCOPC servers created earlier.
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9) Right-click the first GCOPC service with the mouse pointer. Highlight the New menu. It

will expand to another menu screen. Click the Key submenu.
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10) A new folder labeled ‘New Key #1' appears. Using the computer’s keyboard, change this

folder’s name to ‘Parameters’, and press the Enter key to save the change.
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11) Move the mouse pointer to the large screen area to the right, and right-click with the mouse.

The following submenus will appear. Highlight the New menu, then move the mouse pointer

to ‘String Value’ and left-click.
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12) A new entry will appear labeled ‘New Value #1'. Using the computer’s keyboard change this

name to ‘Application’, and press the Enter key to save the change.

13) Right-click the new ‘Application’ entry. The following dialog will appear. Highlight and

left-click the Modify menu.
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14) Type the following path into the Value Data field of the Edit String dialog box with your

server name in place of ‘Server 1':

C:\Program Files\Emerson Process Management\GCOPCCFG\Server1\GCOPC.exe 

15) Click the OK button to save the entry. 

16) Steps 9 thru 15 must be repeated for each server that was created in Section 3.0, Operation.

17) When all servers have been configured, close the registry. 
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The GCOPC servers are now ready to run as NT Services. By default the GCOPC services Startup

Type are set to Automatic and will begin each time the computer is started. They can also be

manually stopped and started from the Control Panel > Administrative Tools > Services window.

Refer to the following screen examples.
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5.0 PORT DEFINITION FILE FORMAT

The port definition files are ASCII text files as follows:

GUID: required to be the first line of the file.

FAD94BFB-C610-4e3c-988A-A34815AED6A0

DA register blocks:

B`regno`numregs`strmno (strmno is stream number), where regno is the starting register

number and numregs is the number of registers in the block (i.e. B`7623`28).

DA register definitions:

R`name`type`ro/rw, where name is the tag name of the register, type is the data type (F –

float, I – int16, L – int32, or B – Boolean), and ro/rw is read-only or read/write (i.e.

R`Hydrogen`F`RW).

DA Quality code register definitions:

Q`regno`numregs`strmno, where regno is the starting register number and numregs is the

number of registers (i.e. Q`5018`28). If quality codes are to be read from the GC, there

should be one quality code register for each DA data register. Otherwise, GCOPC will

provide the quality codes.

DA Timestamp register definitions:

T`regno`numregs`strmno, where regno is the starting register number and numregs is the

number of registers (i.e. T`7621`2). Current implementation is such that 2 registers (one for

date and the other for time) contain the date and time for all of the DA data.

HDA register definitions:

H`regno`numrecs`strmno, where regno is the register number and numrecs is the number of

archive records that may be retrieved from that register (i.e. H`751`254).

HDA newest record register:

N`regno, where regno is the register from which to read the record number of the newest

archive record (i.e. N`regno`strmno).

HDA database dimensions:

D`maxrecs`items/rec`strmno, where maxrecs is the maximum number of archive records and

items/rec is the number of data points within that archive (i.e. D`761`28).
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HDA record items:

I`strmno`name`type`units`description, where name is the name of the data item, type is the

data type (F, I, L, or B per above), units is the engineering units associated with the item, and

description is a brief description of that item (i.e.I`Hydrogen`F`Mole %`Mole Percent –

Hydrogen). These lines should be ordered consistently with the ordering of the items within

the archive.
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6.0 SAMPLE PORT DEFINITION FILE

The following is a listing of the sample port definition file.

FAD94BFB-C61D-4e3c-988A-A34815AFD6A0

// DA Register block (B`regno`numregs`strmno)

B`7623`28`1

// DA Registers (R`name`type`ro/rw)

R`Strm1-Mole%-Hydrogen`F`RO

R`Strm1-Mole%-Nitrogen`F`RO

R`Strm1-Mole%-Carbon_Monoxide`F`RO

R`Strm1-Mole%-Methane`F`RO

R`Strm1-Mole%-C5+`F`RO

R`Strm1-Mole%-Propane`F`RO

R`Strm1-Mole%-Propylene`F`RO

R`Strm1-Mole%-i-Butane`F`RO

R`Strm1-Mole%-n-Butane`F`RO

R`Strm1-Mole%-Butene-1`F`RO

R`Strm1-Mole%-Trans-2-Butene`F`RO

R`Strm1-Mole%-CIS-2-Butene`F`RO

R`Strm1-Mole%-1,3-Butadiene`F`RO

R`Strm1-Mole%-Carbon_Dioxide`F`RO

R`Strm1-Mole%-Ethylene`F`RO

R`Strm1-Mole%-Ethane`F`RO

R`Strm1-Spare_1`F`RO

R`Strm1-Spare_2`F`RO

R`Strm1-Net_BTU_Dry`F`RO

R`Strm1-Relative_Density`F`RO

R`Strm1-Unnormalized_Total_Mole%`F`RO

R`Strm1-User_Calculation_#1`F`RO

R`Strm1-User_Calculation_#2`F`RO

R`Strm1-User_Calculation_#3`F`RO

R`Strm1-Flare_Temperature`F`RO

R`Strm1-Flare_Pressure`F`RO

R`Strm1-Flare_Flowrate`F`RO

R`Strm1-Spare_3`F`RO

B`7527`18`1

R`Strm1-Weight%-Hydrogen`F`RO

R`Strm1-Weight%-Nitrogen`F`RO

R`Strm1-Weight%-Carbon_Monoxide`F`RO

R`Strm1-Weight%-Methane`F`RO
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R`Strm1-Weight%-C5+`F`RO

R`Strm1-Weight%-Propane`F`RO

R`Strm1-Weight%-Propylene`F`RO

R`Strm1-Weight%-i-Butane`F`RO

R`Strm1-Weight%-n-Butane`F`RO

R`Strm1-Weight%-Butene-1`F`RO

R`Strm1-Weight%-Trans-2-Butene`F`RO

R`Strm1-Weight%-CIS-2-Butene`F`RO

R`Strm1-Weight%-1,3-Butadiene`F`RO

R`Strm1-Weight%-Carbon_Dioxide`F`RO

R`Strm1-Weight%-Ethylene`F`RO

R`Strm1-Weight%-Ethane`F`RO

R`Strm1-Spare_4`F`RO

R`Strm1-Spare_5`F`RO

// DA Quality code registers (Q`regno`numregs`strmno)

// None for now

// DA Timestamp registers (T`regno`numregs`strmno)

T`7621`2`1

// DA Register block (B`regno`numregs`strmno)

B`7653`28`2

// DA Registers (R`name`type`ro/rw)

R`Strm2-Mole%-Hydrogen`F`RO

R`Strm2-Mole%-Nitrogen`F`RO

R`Strm2-Mole%-Carbon_Monoxide`F`RO

R`Strm2-Mole%-Methane`F`RO

R`Strm2-Mole%-C5+`F`RO

R`Strm2-Mole%-Propane`F`RO

R`Strm2-Mole%-Propylene`F`RO

R`Strm2-Mole%-i-Butane`F`RO

R`Strm2-Mole%-n-Butane`F`RO

R`Strm2-Mole%-Butene-1`F`RO

R`Strm2-Mole%-Trans-2-Butene`F`RO

R`Strm2-Mole%-CIS-2-Butene`F`RO

R`Strm2-Mole%-1,3-Butadiene`F`RO

R`Strm2-Mole%-Carbon_Dioxide`F`RO

R`Strm2-Mole%-Ethylene`F`RO

R`Strm2-Mole%-Ethane`F`RO

R`Strm2-Spare_1`F`RO

R`Strm2-Spare_2`F`RO

R`Strm2-Net_BTU_Dry`F`RO

R`Strm2-Relative_Density`F`RO
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R`Strm2-Unnormalized_Total_Mole%`F`RO

R`Strm2-User_Calculation_#1`F`RO

R`Strm2-User_Calculation_#2`F`RO

R`Strm2-User_Calculation_#3`F`RO

R`Strm2-Flare_Temperature`F`RO

R`Strm2-Flare_Pressure`F`RO

R`Strm2-Flare_Flowrate`F`RO

R`Strm2-Spare_3`F`RO

B`7545`18`2

R`Strm2-Weight%-Hydrogen`F`RO

R`Strm2-Weight%-Nitrogen`F`RO

R`Strm2-Weight%-Carbon_Monoxide`F`RO

R`Strm2-Weight%-Methane`F`RO

R`Strm2-Weight%-C5+`F`RO

R`Strm2-Weight%-Propane`F`RO

R`Strm2-Weight%-Propylene`F`RO

R`Strm2-Weight%-i-Butane`F`RO

R`Strm2-Weight%-n-Butane`F`RO

R`Strm2-Weight%-Butene-1`F`RO

R`Strm2-Weight%-Trans-2-Butene`F`RO

R`Strm2-Weight%-CIS-2-Butene`F`RO

R`Strm2-Weight%-1,3-Butadiene`F`RO

R`Strm2-Weight%-Carbon_Dioxide`F`RO

R`Strm2-Weight%-Ethylene`F`RO

R`Strm2-Weight%-Ethane`F`RO

R`Strm2-Spare_4`F`RO

R`Strm2-Spare_5`F`RO

// DA Quality code registers (Q`regno`numregs`strmno)

// None for now

// DA Timestamp registers (T`regno`numregs`strmno)

T`7651`2`2

// DA Register block (B`regno`numregs`strmno)

B`7683`28`3

// DA Registers (R`name`type`ro/rw)

R`Strm3-Mole%-Hydrogen`F`RO

R`Strm3-Mole%-Nitrogen`F`RO

R`Strm3-Mole%-Carbon_Monoxide`F`RO

R`Strm3-Mole%-Methane`F`RO

R`Strm3-Mole%-C5+`F`RO

R`Strm3-Mole%-Propane`F`RO

R`Strm3-Mole%-Propylene`F`RO
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R`Strm3-Mole%-i-Butane`F`RO

R`Strm3-Mole%-n-Butane`F`RO

R`Strm3-Mole%-Butene-1`F`RO

R`Strm3-Mole%-Trans-2-Butene`F`RO

R`Strm3-Mole%-CIS-2-Butene`F`RO

R`Strm3-Mole%-1,3-Butadiene`F`RO

R`Strm3-Mole%-Carbon_Dioxide`F`RO

R`Strm3-Mole%-Ethylene`F`RO

R`Strm3-Mole%-Ethane`F`RO

R`Strm3-Spare_1`F`RO

R`Strm3-Spare_2`F`RO

R`Strm3-Net_BTU_Dry`F`RO

R`Strm3-Relative_Density`F`RO

R`Strm3-Unnormalized_Total_Mole%`F`RO

R`Strm3-User_Calculation_#1`F`RO

R`Strm3-User_Calculation_#2`F`RO

R`Strm3-User_Calculation_#3`F`RO

R`Strm3-Flare_Temperature`F`RO

R`Strm3-Flare_Pressure`F`RO

R`Strm3-Flare_Flowrate`F`RO

R`Strm3-Spare_3`F`RO

B`7563`18`3

R`Strm3-Weight%-Hydrogen`F`RO

R`Strm3-Weight%-Nitrogen`F`RO

R`Strm3-Weight%-Carbon_Monoxide`F`RO

R`Strm3-Weight%-Methane`F`RO

R`Strm3-Weight%-C5+`F`RO

R`Strm3-Weight%-Propane`F`RO

R`Strm3-Weight%-Propylene`F`RO

R`Strm3-Weight%-i-Butane`F`RO

R`Strm3-Weight%-n-Butane`F`RO

R`Strm3-Weight%-Butene-1`F`RO

R`Strm3-Weight%-Trans-2-Butene`F`RO

R`Strm3-Weight%-CIS-2-Butene`F`RO

R`Strm3-Weight%-1,3-Butadiene`F`RO

R`Strm3-Weight%-Carbon_Dioxide`F`RO

R`Strm3-Weight%-Ethylene`F`RO

R`Strm3-Weight%-Ethane`F`RO

R`Strm3-Spare_4`F`RO

R`Strm3-Spare_5`F`RO

// DA Quality code registers (Q`regno`numregs`strmno)
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// None for now

// DA Timestamp registers (T`regno`numregs`strmno)

T`7681`2`3

// DA Register block (B`regno`numregs`strmno)

B`7713`28`4

// DA Registers (R`name`type`ro/rw)

R`Strm4-Mole%-Hydrogen`F`RO

R`Strm4-Mole%-Nitrogen`F`RO

R`Strm4-Mole%-Carbon_Monoxide`F`RO

R`Strm4-Mole%-Methane`F`RO

R`Strm4-Mole%-C5+`F`RO

R`Strm4-Mole%-Propane`F`RO

R`Strm4-Mole%-Propylene`F`RO

R`Strm4-Mole%-i-Butane`F`RO

R`Strm4-Mole%-n-Butane`F`RO

R`Strm4-Mole%-Butene-1`F`RO

R`Strm4-Mole%-Trans-2-Butene`F`RO

R`Strm4-Mole%-CIS-2-Butene`F`RO

R`Strm4-Mole%-1,3-Butadiene`F`RO

R`Strm4-Mole%-Carbon_Dioxide`F`RO

R`Strm4-Mole%-Ethylene`F`RO

R`Strm4-Mole%-Ethane`F`RO

R`Strm4-Spare_1`F`RO

R`Strm4-Spare_2`F`RO

R`Strm4-Net_BTU_Dry`F`RO

R`Strm4-Relative_Density`F`RO

R`Strm4-Unnormalized_Total_Mole%`F`RO

R`Strm4-User_Calculation_#1`F`RO

R`Strm4-User_Calculation_#2`F`RO

R`Strm4-User_Calculation_#3`F`RO

R`Strm4-Flare_Temperature`F`RO

R`Strm4-Flare_Pressure`F`RO

R`Strm4-Flare_Flowrate`F`RO

R`Strm4-Spare_3`F`RO

B`7581`18`4

R`Strm4-Weight%-Hydrogen`F`RO

R`Strm4-Weight%-Nitrogen`F`RO

R`Strm4-Weight%-Carbon_Monoxide`F`RO

R`Strm4-Weight%-Methane`F`RO

R`Strm4-Weight%-C5+`F`RO

R`Strm4-Weight%-Propane`F`RO
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R`Strm4-Weight%-Propylene`F`RO

R`Strm4-Weight%-i-Butane`F`RO

R`Strm4-Weight%-n-Butane`F`RO

R`Strm4-Weight%-Butene-1`F`RO

R`Strm4-Weight%-Trans-2-Butene`F`RO

R`Strm4-Weight%-CIS-2-Butene`F`RO

R`Strm4-Weight%-1,3-Butadiene`F`RO

R`Strm4-Weight%-Carbon_Dioxide`F`RO

R`Strm4-Weight%-Ethylene`F`RO

R`Strm4-Weight%-Ethane`F`RO

R`Strm4-Spare_4`F`RO

R`Strm4-Spare_5`F`RO

// DA Quality code registers (Q`regno`numregs`strmno)

// None for now

// DA Timestamp registers (T`regno`numregs`strmno)

T`7711`2`4

// DA Register block (B`regno`numregs`strmno)

B`7743`28`5

// DA Registers (R`name`type`ro/rw)

R`Strm5-Mole%-Hydrogen`F`RO

R`Strm5-Mole%-Nitrogen`F`RO

R`Strm5-Mole%-Carbon_Monoxide`F`RO

R`Strm5-Mole%-Methane`F`RO

R`Strm5-Mole%-C5+`F`RO

R`Strm5-Mole%-Propane`F`RO

R`Strm5-Mole%-Propylene`F`RO

R`Strm5-Mole%-i-Butane`F`RO

R`Strm5-Mole%-n-Butane`F`RO

R`Strm5-Mole%-Butene-1`F`RO

R`Strm5-Mole%-Trans-2-Butene`F`RO

R`Strm5-Mole%-CIS-2-Butene`F`RO

R`Strm5-Mole%-1,3-Butadiene`F`RO

R`Strm5-Mole%-Carbon_Dioxide`F`RO

R`Strm5-Mole%-Ethylene`F`RO

R`Strm5-Mole%-Ethane`F`RO

R`Strm5-Spare_1`F`RO

R`Strm5-Spare_2`F`RO

R`Strm5-Net_BTU_Dry`F`RO

R`Strm5-Relative_Density`F`RO

R`Strm5-Unnormalized_Total_Mole%`F`RO

R`Strm5-User_Calculation_#1`F`RO
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R`Strm5-User_Calculation_#2`F`RO

R`Strm5-User_Calculation_#3`F`RO

R`Strm5-Flare_Temperature`F`RO

R`Strm5-Flare_Pressure`F`RO

R`Strm5-Flare_Flowrate`F`RO

R`Strm5-Spare_3`F`RO

B`7491`18`5

R`Strm5-Weight%-Hydrogen`F`RO

R`Strm5-Weight%-Nitrogen`F`RO

R`Strm5-Weight%-Carbon_Monoxide`F`RO

R`Strm5-Weight%-Methane`F`RO

R`Strm5-Weight%-C5+`F`RO

R`Strm5-Weight%-Propane`F`RO

R`Strm5-Weight%-Propylene`F`RO

R`Strm5-Weight%-i-Butane`F`RO

R`Strm5-Weight%-n-Butane`F`RO

R`Strm5-Weight%-Butene-1`F`RO

R`Strm5-Weight%-Trans-2-Butene`F`RO

R`Strm5-Weight%-CIS-2-Butene`F`RO

R`Strm5-Weight%-1,3-Butadiene`F`RO

R`Strm5-Weight%-Carbon_Dioxide`F`RO

R`Strm5-Weight%-Ethylene`F`RO

R`Strm5-Weight%-Ethane`F`RO

R`Strm5-Spare_4`F`RO

R`Strm5-Spare_5`F`RO

// DA Quality code registers (Q`regno`numregs`strmno)

// None for now

// DA Timestamp registers (T`regno`numregs`strmno)

T`7741`2`5

// DA Register block (B`regno`numregs`strmno)

B`7773`28`6

// DA Registers (R`name`type`ro/rw)

R`Strm6-Mole%-Hydrogen`F`RO

R`Strm6-Mole%-Nitrogen`F`RO

R`Strm6-Mole%-Carbon_Monoxide`F`RO

R`Strm6-Mole%-Methane`F`RO

R`Strm6-Mole%-C5+`F`RO

R`Strm6-Mole%-Propane`F`RO

R`Strm6-Mole%-Propylene`F`RO

R`Strm6-Mole%-i-Butane`F`RO

R`Strm6-Mole%-n-Butane`F`RO
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R`Strm6-Mole%-Butene-1`F`RO

R`Strm6-Mole%-Trans-2-Butene`F`RO

R`Strm6-Mole%-CIS-2-Butene`F`RO

R`Strm6-Mole%-1,3-Butadiene`F`RO

R`Strm6-Mole%-Carbon_Dioxide`F`RO

R`Strm6-Mole%-Ethylene`F`RO

R`Strm6-Mole%-Ethane`F`RO

R`Strm6-Spare_1`F`RO

R`Strm6-Spare_2`F`RO

R`Strm6-Net_BTU_Dry`F`RO

R`Strm6-Relative_Density`F`RO

R`Strm6-Unnormalized_Total_Mole%`F`RO

R`Strm6-User_Calculation_#1`F`RO

R`Strm6-User_Calculation_#2`F`RO

R`Strm6-User_Calculation_#3`F`RO

R`Strm6-Flare_Temperature`F`RO

R`Strm6-Flare_Pressure`F`RO

R`Strm6-Flare_Flowrate`F`RO

R`Strm6-Spare_3`F`RO

B`7509`18`6

R`Strm6-Weight%-Hydrogen`F`RO

R`Strm6-Weight%-Nitrogen`F`RO

R`Strm6-Weight%-Carbon_Monoxide`F`RO

R`Strm6-Weight%-Methane`F`RO

R`Strm6-Weight%-C5+`F`RO

R`Strm6-Weight%-Propane`F`RO

R`Strm6-Weight%-Propylene`F`RO

R`Strm6-Weight%-i-Butane`F`RO

R`Strm6-Weight%-n-Butane`F`RO

R`Strm6-Weight%-Butene-1`F`RO

R`Strm6-Weight%-Trans-2-Butene`F`RO

R`Strm6-Weight%-CIS-2-Butene`F`RO

R`Strm6-Weight%-1,3-Butadiene`F`RO

R`Strm6-Weight%-Carbon_Dioxide`F`RO

R`Strm6-Weight%-Ethylene`F`RO

R`Strm6-Weight%-Ethane`F`RO

R`Strm6-Spare_4`F`RO

R`Strm6-Spare_5`F`RO

// DA Quality code registers (Q`regno`numregs`strmno)

// None for now

// DA Timestamp registers (T`regno`numregs`strmno)
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T`7771`2`6

// HDA database dimensions (D`maxrecs`items/rec`strmno)

D`762`28`1

D`762`28`2

D`762`28`3

D`762`28`4

D`762`28`5

D`762`28`6

// HDA newest record register (N`regno`strmno)

N`3112`1

N`3115`2

N`3118`3

N`3121`4

N`3124`5

N`3127`6

// HDA register to from which to read records (H`regno`numrecs`strmno)

H`751`254`1

H`761`254`1

H`771`254`1

H`752`254`2

H`762`254`2

H`772`254`2

H`753`254`3

H`763`254`3

H`773`254`3

H`754`254`4

H`764`254`4

H`774`254`4

H`755`254`5

H`765`254`5

H`775`254`5

H`756`254`6

H`766`254`6

H`776`254`6

// HDA record items (in order) (I`strmno`name`type`units`description)

I`1`Strm1-Weight%-Hydrogen`F`Weight %`Stream 1 - Weight Percent - Hydrogen

I`1`Strm1-Weight%-Nitrogen`F`Weight %`Stream 1 - Weight Percent - Nitrogen

I`1`Strm1-Weight%-Carbon_Monoxide`F`Weight %`Stream 1 - Weight Percent - Carbon Monoxide

I`1`Strm1-Weight%-Methane`F`Weight %`Stream 1 - Weight Percent - Methane

I`1`Strm1-Weight%-C5+`F`Weight %`Stream 1 - Weight Percent - C5+

I`1`Strm1-Weight%-Propane`F`Weight %`Stream 1 - Weight Percent - Propane
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I`1`Strm1-Weight%-Propylene`F`Weight %`Stream 1 - Weight Percent - Propylene

I`1`Strm1-Weight%-i-Butane`F`Weight %`Stream 1 - Weight Percent - i-Butane

I`1`Strm1-Weight%-n-Butane`F`Weight %`Stream 1 - Weight Percent - n-Butane

I`1`Strm1-Weight%-Butene-1`F`Weight %`Stream 1 - Weight Percent - Butene-1

I`1`Strm1-Weight%-Trans-2-Butene`F`Weight %`Stream 1 - Weight Percent - Trans-2-Butene

I`1`Strm1-Weight%-CIS-2-Butene`F`Weight %`Stream 1 - Weight Percent - CIS-2-Butene

I`1`Strm1-Weight%-1,3-Butadiene`F`Weight %`Stream 1 - Weight Percent - 1,3-Butadiene

I`1`Strm1-Weight%-Carbon_Dioxide`F`Weight %`Stream 1 - Weight Percent - Carbon Dioxide

I`1`Strm1-Weight%-Ethylene`F`Weight %`Weight Stream 1 - Percent - Ethylene

I`1`Strm1-Weight%-Ethane`F`Weight %`Stream 1 - Weight Percent - Ethane

I`1`Strm1-Spare_1`F``

I`1`Strm1-Spare_2`F``

I`1`Strm1-Net_BTU_Dry`F`BTU`Stream 1 - Net Dry BTU

I`1`Strm1-Relative_Density`F``Stream 1 - Relative Density

I`1`Strm1-Unnormalized_Total_Mole%`F`Mole %`Stream 1 - Unnormalized Total Mole Percent

I`1`Strm1-User_Calculation_#1`F``Stream 1 - User Calculation #1

I`1`Strm1-User_Calculation_#2`F``Stream 1 - User Calculation #2

I`1`Strm1-User_Calculation_#3`F``Stream 1 - User Calculation #3

I`1`Strm1-Flare_Temperature`F`DEG F`Stream 1 - Flare Temperature (average during analysis from

samples every 4 seconds)

I`1`Strm1-Flare_Pressure`F`PSIA`Stream 1 - Flare Pressure (average during analysis from samples

every 4 seconds)

I`1`Strm1-Flare_Flowrate`F`BBLS/HR`Stream 1 - Flare Flowrate (average during analysis from

samples every 4 seconds)

I`1`Strm1-Spare_3`F``

I`2`Strm2-Weight%-Hydrogen`F`Weight %`Stream 2 - Weight Percent - Hydrogen

I`2`Strm2-Weight%-Nitrogen`F`Weight %`Stream 2 - Weight Percent - Nitrogen

I`2`Strm2-Weight%-Carbon_Monoxide`F`Weight %`Stream 2 - Weight Percent - Carbon Monoxide

I`2`Strm2-Weight%-Methane`F`Weight %`Stream 2 - Weight Percent - Methane

I`2`Strm2-Weight%-C5+`F`Weight %`Stream 2 - Weight Percent - C5+

I`2`Strm2-Weight%-Propane`F`Weight %`Stream 2 - Weight Percent - Propane

I`2`Strm2-Weight%-Propylene`F`Weight %`Stream 2 - Weight Percent - Propylene

I`2`Strm2-Weight%-i-Butane`F`Weight %`Stream 2 - Weight Percent - i-Butane

I`2`Strm2-Weight%-n-Butane`F`Weight %`Stream 2 - Weight Percent - n-Butane

I`2`Strm2-Weight%-Butene-1`F`Weight %`Stream 2 - Weight Percent - Butene-1

I`2`Strm2-Weight%-Trans-2-Butene`F`Weight %`Stream 2 - Weight Percent - Trans-2-Butene

I`2`Strm2-Weight%-CIS-2-Butene`F`Weight %`Stream 2 - Weight Percent - CIS-2-Butene

I`2`Strm2-Weight%-1,3-Butadiene`F`Weight %`Stream 2 - Weight Percent - 1,3-Butadiene

I`2`Strm2-Weight%-Carbon_Dioxide`F`Weight %`Stream 2 - Weight Percent - Carbon Dioxide

I`2`Strm2-Weight%-Ethylene`F`Weight %`Weight Stream 2 - Percent - Ethylene

I`2`Strm2-Weight%-Ethane`F`Weight %`Stream 2 - Weight Percent - Ethane
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I`2`Strm2-Spare_1`F``

I`2`Strm2-Spare_2`F``

I`2`Strm2-Net_BTU_Dry`F`BTU`Stream 2 - Net Dry BTU

I`2`Strm2-Relative_Density`F``Stream 2 - Relative Density

I`2`Strm2-Unnormalized_Total_Mole%`F`Mole %`Stream 2 - Unnormalized Total Mole Percent

I`2`Strm2-User_Calculation_#1`F``Stream 2 - User Calculation #1

I`2`Strm2-User_Calculation_#2`F``Stream 2 - User Calculation #2

I`2`Strm2-User_Calculation_#3`F``Stream 2 - User Calculation #3

I`2`Strm2-Flare_Temperature`F`DEG F`Stream 2 - Flare Temperature (average during analysis from

samples every 4 seconds)

I`2`Strm2-Flare_Pressure`F`PSIA`Stream 2 - Flare Pressure (average during analysis from samples

every 4 seconds)

I`2`Strm2-Flare_Flowrate`F`BBLS/HR`Stream 2 - Flare Flowrate (average during analysis from

samples every 4 seconds)

I`2`Strm2-Spare_3`F``

I`3`Strm3-Weight%-Hydrogen`F`Weight %`Stream 3 - Weight Percent - Hydrogen

I`3`Strm3-Weight%-Nitrogen`F`Weight %`Stream 3 - Weight Percent - Nitrogen

I`3`Strm3-Weight%-Carbon_Monoxide`F`Weight %`Stream 3 - Weight Percent - Carbon Monoxide

I`3`Strm3-Weight%-Methane`F`Weight %`Stream 3 - Weight Percent - Methane

I`3`Strm3-Weight%-C5+`F`Weight %`Stream 3 - Weight Percent - C5+

I`3`Strm3-Weight%-Propane`F`Weight %`Stream 3 - Weight Percent - Propane

I`3`Strm3-Weight%-Propylene`F`Weight %`Stream 3 - Weight Percent - Propylene

I`3`Strm3-Weight%-i-Butane`F`Weight %`Stream 3 - Weight Percent - i-Butane

I`3`Strm3-Weight%-n-Butane`F`Weight %`Stream 3 - Weight Percent - n-Butane

I`3`Strm3-Weight%-Butene-1`F`Weight %`Stream 3 - Weight Percent - Butene-1

I`3`Strm3-Weight%-Trans-2-Butene`F`Weight %`Stream 3 - Weight Percent - Trans-2-Butene

I`3`Strm3-Weight%-CIS-2-Butene`F`Weight %`Stream 3 - Weight Percent - CIS-2-Butene

I`3`Strm3-Weight%-1,3-Butadiene`F`Weight %`Stream 3 - Weight Percent - 1,3-Butadiene

I`3`Strm3-Weight%-Carbon_Dioxide`F`Weight %`Stream 3 - Weight Percent - Carbon Dioxide

I`3`Strm3-Weight%-Ethylene`F`Weight %`Weight Stream 3 - Percent - Ethylene

I`3`Strm3-Weight%-Ethane`F`Weight %`Stream 3 - Weight Percent - Ethane

I`3`Strm3-Spare_1`F``

I`3`Strm3-Spare_2`F``

I`3`Strm3-Net_BTU_Dry`F`BTU`Stream 3 - Net Dry BTU

I`3`Strm3-Relative_Density`F``Stream 3 - Relative Density

I`3`Strm3-Unnormalized_Total_Mole%`F`Mole %`Stream 3 - Unnormalized Total Mole Percent

I`3`Strm3-User_Calculation_#1`F``Stream 3 - User Calculation #1

I`3`Strm3-User_Calculation_#2`F``Stream 3 - User Calculation #2

I`3`Strm3-User_Calculation_#3`F``Stream 3 - User Calculation #3

I`3`Strm3-Flare_Temperature`F`DEG F`Stream 3 - Flare Temperature (average during analysis from

samples every 4 seconds)
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I`3`Strm3-Flare_Pressure`F`PSIA`Stream 3 - Flare Pressure (average during analysis from samples

every 4 seconds)

I`3`Strm3-Flare_Flowrate`F`BBLS/HR`Stream 3 - Flare Flowrate (average during analysis from

samples every 4 seconds)

I`3`Strm3-Spare_3`F``

I`4`Strm4-Weight%-Hydrogen`F`Weight %`Stream 4 - Weight Percent - Hydrogen

I`4`Strm4-Weight%-Nitrogen`F`Weight %`Stream 4 - Weight Percent - Nitrogen

I`4`Strm4-Weight%-Carbon_Monoxide`F`Weight %`Stream 4 - Weight Percent - Carbon Monoxide

I`4`Strm4-Weight%-Methane`F`Weight %`Stream 4 - Weight Percent - Methane

I`4`Strm4-Weight%-C5+`F`Weight %`Stream 4 - Weight Percent - C5+

I`4`Strm4-Weight%-Propane`F`Weight %`Stream 4 - Weight Percent - Propane

I`4`Strm4-Weight%-Propylene`F`Weight %`Stream 4 - Weight Percent - Propylene

I`4`Strm4-Weight%-i-Butane`F`Weight %`Stream 4 - Weight Percent - i-Butane

I`4`Strm4-Weight%-n-Butane`F`Weight %`Stream 4 - Weight Percent - n-Butane

I`4`Strm4-Weight%-Butene-1`F`Weight %`Stream 4 - Weight Percent - Butene-1

I`4`Strm4-Weight%-Trans-2-Butene`F`Weight %`Stream 4 - Weight Percent - Trans-2-Butene

I`4`Strm4-Weight%-CIS-2-Butene`F`Weight %`Stream 4 - Weight Percent - CIS-2-Butene

I`4`Strm4-Weight%-1,3-Butadiene`F`Weight %`Stream 4 - Weight Percent - 1,3-Butadiene

I`4`Strm4-Weight%-Carbon_Dioxide`F`Weight %`Stream 4 - Weight Percent - Carbon Dioxide

I`4`Strm4-Weight%-Ethylene`F`Weight %`Weight Stream 4 - Percent - Ethylene

I`4`Strm4-Weight%-Ethane`F`Weight %`Stream 4 - Weight Percent - Ethane

I`4`Strm4-Spare_1`F``

I`4`Strm4-Spare_2`F``

I`4`Strm4-Net_BTU_Dry`F`BTU`Stream 4 - Net Dry BTU

I`4`Strm4-Relative_Density`F``Stream 4 - Relative Density

I`4`Strm4-Unnormalized_Total_Mole%`F`Mole %`Stream 4 - Unnormalized Total Mole Percent

I`4`Strm4-User_Calculation_#1`F``Stream 4 - User Calculation #1

I`4`Strm4-User_Calculation_#2`F``Stream 4 - User Calculation #2

I`4`Strm4-User_Calculation_#3`F``Stream 4 - User Calculation #3

I`4`Strm4-Flare_Temperature`F`DEG F`Stream 4 - Flare Temperature (average during analysis from

samples every 4 seconds)

I`4`Strm4-Flare_Pressure`F`PSIA`Stream 4 - Flare Pressure (average during analysis from samples

every 4 seconds)

I`4`Strm4-Flare_Flowrate`F`BBLS/HR`Stream 4 - Flare Flowrate (average during analysis from

samples every 4 seconds)

I`4`Strm4-Spare_3`F``

I`5`Strm5-Weight%-Hydrogen`F`Weight %`Stream 5 - Weight Percent - Hydrogen

I`5`Strm5-Weight%-Nitrogen`F`Weight %`Stream 5 - Weight Percent - Nitrogen

I`5`Strm5-Weight%-Carbon_Monoxide`F`Weight %`Stream 5 - Weight Percent - Carbon Monoxide

I`5`Strm5-Weight%-Methane`F`Weight %`Stream 5 - Weight Percent - Methane

I`5`Strm5-Weight%-C5+`F`Weight %`Stream 5 - Weight Percent - C5+
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I`5`Strm5-Weight%-Propane`F`Weight %`Stream 5 - Weight Percent - Propane

I`5`Strm5-Weight%-Propylene`F`Weight %`Stream 5 - Weight Percent - Propylene

I`5`Strm5-Weight%-i-Butane`F`Weight %`Stream 5 - Weight Percent - i-Butane

I`5`Strm5-Weight%-n-Butane`F`Weight %`Stream 5 - Weight Percent - n-Butane

I`5`Strm5-Weight%-Butene-1`F`Weight %`Stream 5 - Weight Percent - Butene-1

I`5`Strm5-Weight%-Trans-2-Butene`F`Weight %`Stream 5 - Weight Percent - Trans-2-Butene

I`5`Strm5-Weight%-CIS-2-Butene`F`Weight %`Stream 5 - Weight Percent - CIS-2-Butene

I`5`Strm5-Weight%-1,3-Butadiene`F`Weight %`Stream 5 - Weight Percent - 1,3-Butadiene

I`5`Strm5-Weight%-Carbon_Dioxide`F`Weight %`Stream 5 - Weight Percent - Carbon Dioxide

I`5`Strm5-Weight%-Ethylene`F`Weight %`Weight Stream 5 - Percent - Ethylene

I`5`Strm5-Weight%-Ethane`F`Weight %`Stream 5 - Weight Percent - Ethane

I`5`Strm5-Spare_1`F``

I`5`Strm5-Spare_2`F``

I`5`Strm5-Net_BTU_Dry`F`BTU`Stream 5 - Net Dry BTU

I`5`Strm5-Relative_Density`F``Stream 5 - Relative Density

I`5`Strm5-Unnormalized_Total_Mole%`F`Mole %`Stream 5 - Unnormalized Total Mole Percent

I`5`Strm5-User_Calculation_#1`F``Stream 5 - User Calculation #1

I`5`Strm5-User_Calculation_#2`F``Stream 5 - User Calculation #2

I`5`Strm5-User_Calculation_#3`F``Stream 5 - User Calculation #3

I`5`Strm5-Flare_Temperature`F`DEG F`Stream 5 - Flare Temperature (average during analysis from

samples every 4 seconds)

I`5`Strm5-Flare_Pressure`F`PSIA`Stream 5 - Flare Pressure (average during analysis from samples

every 4 seconds)

I`5`Strm5-Flare_Flowrate`F`BBLS/HR`Stream 5 - Flare Flowrate (average during analysis from

samples every 4 seconds)

I`5`Strm5-Spare_3`F``

I`6`Strm6-Weight%-Hydrogen`F`Weight %`Stream 6 - Weight Percent - Hydrogen

I`6`Strm6-Weight%-Nitrogen`F`Weight %`Stream 6 - Weight Percent - Nitrogen

I`6`Strm6-Weight%-Carbon_Monoxide`F`Weight %`Stream 6 - Weight Percent - Carbon Monoxide

I`6`Strm6-Weight%-Methane`F`Weight %`Stream 6 - Weight Percent - Methane

I`6`Strm6-Weight%-C5+`F`Weight %`Stream 6 - Weight Percent - C5+

I`6`Strm6-Weight%-Propane`F`Weight %`Stream 6 - Weight Percent - Propane

I`6`Strm6-Weight%-Propylene`F`Weight %`Stream 6 - Weight Percent - Propylene

I`6`Strm6-Weight%-i-Butane`F`Weight %`Stream 6 - Weight Percent - i-Butane

I`6`Strm6-Weight%-n-Butane`F`Weight %`Stream 6 - Weight Percent - n-Butane

I`6`Strm6-Weight%-Butene-1`F`Weight %`Stream 6 - Weight Percent - Butene-1

I`6`Strm6-Weight%-Trans-2-Butene`F`Weight %`Stream 6 - Weight Percent - Trans-2-Butene

I`6`Strm6-Weight%-CIS-2-Butene`F`Weight %`Stream 6 - Weight Percent - CIS-2-Butene

I`6`Strm6-Weight%-1,3-Butadiene`F`Weight %`Stream 6 - Weight Percent - 1,3-Butadiene

I`6`Strm6-Weight%-Carbon_Dioxide`F`Weight %`Stream 6 - Weight Percent - Carbon Dioxide

I`6`Strm6-Weight%-Ethylene`F`Weight %`Weight Stream 6 - Percent - Ethylene
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I`6`Strm6-Weight%-Ethane`F`Weight %`Stream 6 - Weight Percent - Ethane

I`6`Strm6-Spare_1`F``

I`6`Strm6-Spare_2`F``

I`6`Strm6-Net_BTU_Dry`F`BTU`Stream 6 - Net Dry BTU

I`6`Strm6-Relative_Density`F``Stream 6 - Relative Density

I`6`Strm6-Unnormalized_Total_Mole%`F`Mole %`Stream 6 - Unnormalized Total Mole Percent

I`6`Strm6-User_Calculation_#1`F``Stream 6 - User Calculation #1

I`6`Strm6-User_Calculation_#2`F``Stream 6 - User Calculation #2

I`6`Strm6-User_Calculation_#3`F``Stream 6 - User Calculation #3

I`6`Strm6-Flare_Temperature`F`DEG F`Stream 6 - Flare Temperature (average during analysis from

samples every 4 seconds)

I`6`Strm6-Flare_Pressure`F`PSIA`Stream 6 - Flare Pressure (average during analysis from samples

every 4 seconds)

I`6`Strm6-Flare_Flowrate`F`BBLS/HR`Stream 6 - Flare Flowrate (average during analysis from

samples every 4 seconds)

I`6`Strm6-Spare_3`F``
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7.0 THEORY OF OPERATION

Each GCOPC server polls a GC for real-time data at the configured server rate. The polled data is

used to update the OPC DA interface values.  These values are then made available to any

subscribed OPC DA clients. The data for each stream will be updated at the end of each analysis

cycle. All data will change at the same time and be associated with a single timestamp (obtained

from the cycle start time for the completed analysis).  

The Sample Port Definition File (Section 6.0) includes three types of real-time data points:

C   Analysis Results

C   User Calculation

C   Temperature, Pressure, and Flowrate

The first type includes the component concentrations, including two spares, the Net Heating Value

(Net BTU Dry), Relative Density ( specific gravity), and Un-normalized Total Mole Percent, all of

which are calculated as part of the standard chromatographic calculations.  

The second type includes the three points labeled User Calculation #1, User Calculation #2, and

User Calculation #3. These allow the user to add up to three special calculations which can be

included in the results. The algorithms are defined by the user and the calculations are performed

with the standard calculations at the end of the analysis; hence the results are updated at the same

time as the standard results.  The MON2000 Software for Gas Chromatographs Manual (P/N 3-

9000-522) includes a discussion of user calculations.  

The third type of points are Flare Temperature, Flare pressure, Flare Flowrate, and Spare 3. These

points are updated at the end of the analysis but their values are calculated by averaging samples of

the analog inputs obtained approximately every 2 seconds during the analysis. At the end of the

analysis the average values so calculated become the “current” values for these points and a new

averaging process is begun for the next analysis. 
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At the end of each analysis a record is added to a file in the GC which includes the values of each

of the DA data points. This file expands to a maximum of 762 records, which at the average analysis

cycle time of four minutes is 2 days, 2 hours, and 48 minutes of analysis results. After 762 records

the oldest record is overwritten with the most recent record, thus the GC always has the results of

the most recent 762 analyses. The record number of the most recently written record is accessible

to the GCOPC via a specified modbus register, and is used to allow the program to determine the

oldest and newest record. Upon startup, the GCOPC program queries the GC to determine the

number of historical records and recollects them all (up to 762). It then creates its own copy of the

file which exists in the GC. When the GCOPC program detects the end of an analysis, it updates its

file to match the updated GC file. This file is used to serve information to the HDA clients in

response to requests for data from selected date/time intervals. Timestamps associated with data

points in the historical data records are set to the cycle start time of the corresponding analysis.
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APPENDIX A

DRAWINGS

This appendix contains the drawing for OPC Server for Gas Chromatographs typical network

architecture.

BE-21298 OPC Server for Gas Chromatographs Typical Network Architecture
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WARRANTY CLAIM PROCEDURES

 

To make a warranty claim, you, the Purchaser, must: 

 

1. Provide Daniel Measurement Services (DMS), a division of Emerson Process Management,

with proof of the Date of Purchase and proof of the Date of Shipment of the product in

question. 

2. Return the product to DMS within twelve (12) months of the date of original shipment of the

product, or within eighteen (18) months of the date of original shipment of the product to

destinations outside of the United States. The Purchaser must prepay any shipping charges.

In addition, the Purchaser is responsible for insuring any product shipped for return, and

assumes the risk of loss of the product during shipment. 

 

3. To obtain Warranty service or to locate the nearest DMS office, sales, or service center call

(713) 827-6314, Fax (713) 827-6312 write to:   

Daniel Measurement Services

a division of Emerson Process Management

11100 Brittmoore Park Drive

Houston, Texas 77041

Or contact DMS via the following site:

www.emersonprocess.com/daniel

4. When contacting DMS for product service, the Purchaser is asked to provide  information

as indicated on the following page entitled "Customer Repair Report".

5. For product returns from locations outside the United States, it will be necessary for you to

obtain the import consignment address so that DMS’s customs broker can handle the

importation with the U.S. Customs Service.

6. DMS offers both on call and contract maintenance service designed to afford single source

responsibility for all its products. 

 

7. DMS reserves the right to make changes at any time to any product to improve its design and

to insure the best available product.





CUSTOMER REPAIR REPORT

FOR SERVICE, COMPLETE THIS FORM, AND RETURN IT ALONG WITH THE AFFECTED EQUIPMENT TO CUSTOMER

SERVICE AT THE ADDRESS INDICATED BELOW.

COMPANY  NAME:

TECHNICAL  CONTACT: PHONE:

REPAIR P. O. #: IF WARRANTY, UNIT S/N:

INVOICE ADDRESS:

SHIPPING ADDRESS:

RETURN SHIPPING METHOD:

EQUIPMENT MODEL #: S/N: FAILURE DATE:

DESCRIPTION OF PROBLEM:

WHAT WAS HAPPENING AT TIME OF FAILURE?

ADDITIONAL COMMENTS:

REPORT  PREPARED BY: TITLE:

IF YOU REQUIRE TECHNICAL ASSISTANCE, PLEASE FAX OR WRITE THE CUSTOMER SERVICE DEPARTMENT AT:

DANIEL MEASUREMENT SERVICES

DIVISION OF EMERSON PROCESS MANAGEMENT  PHONE: (713) 827-6314

ATTN: CUSTOMER SERVICE   FAX: (713) 827-6312

11100 BRITTMOORE PARK DRIVE

HOUSTON, TEXAS 77041

FOR FASTEST SERVICE CONTACT DMS VIA OUR WEBSITE:

www.emersonprocess.com/daniel







Daniel Measurement and Control, Inc., Daniel Measurement Services, Inc.,

and Rosemount Analytical, Inc., Divisions of Emerson Process Management

reserve the right to make changes to any of its products or services

at any time without prior notification in order to improve that product or

service and to supply the best product or service possible.

www.emersonprocess.com/daniel
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